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ASP Ombusman Statement

This program is produced by a member of the Association of Shareware Professionals 
(ASP). ASP wants to make sure that the shareware principle works for you. If you are 
unable to resolve a shareware-related problem with an ASP member by contacting the 
member directly, ASP may be able to help. The ASP Ombudsman can help you resolve 
a dispute or problem with an ASP member, but does not provide technical support for 
members products. Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message 
vie CompuServe Mail to ASP Ombudsman 70007,3536.



Ecopad Fax Order Form

To order Ecopad by fax, print, fill out, and fax the fax order form.

See Also:
Benefits of Registration



Ecopad™ Fax Order Form

Ecopad™
PsL Product #11912

Name:__________________________________________________

Company: _______________________________________________

Address:_________________________________________________

___________________________________________________

City: ___________________________________________________

State:_______________ Postal Code:__________________________

Day Phone (optional):_______________________________________

Evening Phone (optional):___________________________________

Fax (optional):_____________________________________________

E-Mail: (optional):__________________________________________

Disk Type: 3 1/2
Credit Card:
[    ] MasterCard    [    ]    Visa    [    ]    AMEX    [    ]    Discover    [    ]

Credit Card Number: ___________________________________________ Expires: _______

Name On Card: ___________________________________________

Billing Address ___________________________________________

___________________________________________
Price: $19.95
Shipping & Handling: (U.S): $4.00
Shipping & Handling: (Outside the U.S.) $6.00

Total Amount Paid:____________________________________________________

Signature: ___________________________________________

Fax this order form to: 1-713-524-6398



Ecopad Installation

To install Ecopad, simply create a directory for the Ecopad program and copy all the files
in this package into it. You can then run Ecopad by double-clicking on it from the
Windows File Manager, or you can add an icon to a group in Program Manager or to the
Windows 95 Start Bar (for information on how to do this, refer to your Windows
documentation).



System Requirements

Ecopad will run on any IBM compatible computer with Windows 3.1. and 4 megabytes of RAM. 



Evaluation Period

Ecopad is fully functional for 20 days or 60 uses, whichever comes LAST. After the evaluation period 
has expired, Ecopad will close down. You will receive plenty of warning before this happens, and any text
documents created with Ecopad will still be fully readable by any text edit or word processor. The 20 
days/60 uses evaluation period allows maximum flexibility. For example, if you run Ecopad once and 
then set it aside for a year, you will still be able to run it another 59 times before the software expires. 
Similarly, if you run Ecopad 60 times the first day, you will still have another 19 days to evaluate it. Note 
that when Ecopad shuts down, you will be able to reactivate it without re-installing by entering your 
registration information. Thank you for evaluating Ecopad!

See also:

Benefits of Registration

Single License Order Form
Site License Order FormFax order form
How to order with a credit card



Product Support

Technical support is available at no charge by sending electronic mail to 

davossorio@msn.com (Internet)

or by sending postal mail to 

Azure D'or Software
David T. Ossorio
325 S. Washington Ave. #166
Kent, WA    98032
USA

You can also use the above address to report any bugs/problems you have when using Ecopad. Support 
is available to both registered and non-registered users of Ecopad. There is no time limit on the 
availability of support.

Your comments/suggestions for improvement are always welcome.
Thank you for evaluating Ecopad!



Overview
Ecopad™ is a text editor replacement for Windows® Notepad which can print up to 8 pages of condensed
text on one sheet of paper. As easy to use as Notepad, Ecopad helps you save money and trees at the 
same time! Text files can be any size (limited by available memory), and Ecopad can also extract the text 
from files created with the Windows Write word processor. You can print with any font/point size 
supported by Windows    3.1. Ecopad is also fully compatible with any printer supported by Windows 3.1. 

Ecopad includes:

* Five different page layout options - print 1, 2, 4, or 8 condensed pages on each physical sheet of paper

* Print preview
* Separately selectable screen and printing fonts
* The ability to define headers and/or footers on each condensed page

New features in Version 2.x:

* Cool new look!
* Shareware version is now fully functional (does not reverse pages)
* Ecopad can now load/print files of any size
* Ecopad can now load files created with the Windows Write word processor
* Word/sentence count information
* Default point sizes can be set for various page compression options
* Convert between DOS and Windows character sets
* Runs without problems on Windows 95 and Windows NT

See Also:
Benefits of Registration



Benefits of Registration

When you order Ecopad, you will receive a 3.5"" disk with the latest versions of the software (both 16 and 
32-bit), along with a registration number which will prevent the software from shutting down after 20 days 
or 60 uses, whichever comes last. If the software has already expired, you can re-activate it with this 
number.

You can use your registration number to register all future versions of Ecopad (both 16 and 32 bit), so 
updates are always free of charge (except for the cost of downloading).

Additionally, 2% of your total purchase price will be donated to St. Jude Children's Research Hospital. St 
Jude Children's Research Hospital is a non-profit organization which is dedicated to treating and finding a
cure for many types of childhood cancer. Your donation will help over 4,000 children with cancer who are 
currently being treated at St. Jude, and will help the researchers there find more effective ways to cure 
childhood cancer. No family is ever charged for treatment at St. Jude. By purchasing Ecopad, you will be 
helping to make a difference in the lives of thousands of children with cancer.

See Also:

Single License Order Form
Site License Order Form
Fax order form
How to order with a credit card



Copyright/License/Warranty

Ecopad™ and Ecopad32™ are Copyright © 1995,1996 by Azure D'or Software.
All Rights Reserved.

The attached VENDINFO data record is hereby incorporated by reference. Any distribution satisfying all 
the distributions requirements in that data record is hereby authorized.

DISCLAIMER - AGREEMENT

This software is provided as is.
There are no warranties, expressed or implied.

AZURE D'OR DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, 
WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE, AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY 
DISCLAIMED. NEITHER AZURE D'OR NOR ANYONE ELSE WHO HAS BEEN 
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE 
SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE 
EVEN IF AZURE D'OR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES OR CLAIMS. IN NO EVENT SHALL AZURE D'OR'S LIABILITY FOR ANY 
DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE 
SOFTWARE, REGARDLESS OF THE FORM OF CLAIM. THE PERSON USING THE 
SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE 
SOFTWARE.

SOME STATES DO NOT ALLOW THE EXCLUSION OF THE LIMIT OF LIABILITY FOR
CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY 
NOT APPLY TO YOU.

THIS AGREEMENT SHALL BE GOVERNED BY THE LAWS OF THE STATE OF 
WASHINGTON AND SHALL INURE TO THE BENEFIT OF AZURE D'OR AND ANY 
SUCCESSORS, ADMINISTRATORS, HEIRS, AND ASSIGNS, ANY ACTION OR 
PROCEEDING BROUGHT BY EITHER PARTY AGAINST THE OTHER ARISING OUT 
OF OR RELATED TO THIS AGREEMENT SHALL BE BROUGHT ONLY IN A STATE 
OR FEDERAL COURT OF COMPETENT JURISDICTION LOCATED IN KING 
COUNTY, WASHINGTON. THE PARTIES HEREBY CONSENT OT IN PERSONAM 
JURISDICTION OF SAID COURTS.

See also:
Benefits of Registration
Contact Information



Information for Disk Dealers and Distributors

Please see VENDINFO.DIZ for detailed distribution information.
The attached VENDINFO data record is hereby incorporated by reference. Any distribution satisfying all 
the distributions requirements in that data record is hereby authorized.

See also:
Benefits of Registration
Contact Information



Commonly Asked Questions

What are the benefits of registering Ecopad?
How large a file can I open?
Can I print files created by commercial word processors such as Word for Windows?
How do I print with a very small (4 or 5 point) font?
What is SHAREWARE?



How large a file can I open?

Ecopad can open files of any size (limited by available memory), however, files larger than about 64,000 
characters can only be opened as read-only.



What is Shareware?

Shareware distribution gives users a chance to try software before buying it. If you try a Shareware 
program and continue using it, you are expected to register. Individual programs differ on details -- some 
request registration while others require it, some specify a maximum trial period. With registration, you get
anything from the simple right to continue using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder retains all 
rights, with a few specific exceptions as stated below. Shareware authors are accomplished 
programmers, just like commercial authors, and the programs are of comparable quality. (In both cases, 
there are good programs and bad ones!) The main difference is in the method of distribution. The author 
specifically grants the right to copy and distribute the software, either to all and sundry or to a specific 
group.

Shareware is a distribution method, not a type of software. You should find software that suits your needs 
and pocketbook,    whether it's commercial or Shareware. The Shareware system makes fitting your 
needs easier, because you can try before you buy. And because the overhead is low, prices are low also. 
Shareware has the ultimate money-back guarantee -- if you don't use the product, you don't pay for it.



Can I print files created by commercial word processors such as Word for Windows?

Word processors insert special private formatting codes into their document which text editors like 
Ecopad dont understand. Thus you can usually load these kinds of files, but in addition to text you will 
also see varying amounts of "garbage" characters. For best results, you should save the file you want to 
load as plain text or "ASCII". The documentation for you word processor should tell you how to do this. 
Once saved as plain text, you can load a file into Ecopad (or any other text editor) without problems.

Note that there is an exception: Ecopad can extract the text from files created with the Windows Write 
word processor. You can load Windows Write files directly into Ecopad (as read-only files) without first 
saving as plain text from Write.



How do I print with a very small (4 or 5 point) font?

In any Windows application (including Ecopad), you can specify the point size of any TrueType font by 
simply typing the desired point size in the "Size" textbox of the Choose Font dialog box (the list box will 
only display point sizes as small as 8, so you have to type the size in yourself if you want anything 
smaller).



Document Information (File Menu)

Use the command to display the size, number of words, lines, and sentences of the document.

Shortcuts
Keys: CTRL+I



Delete (Edit Menu)

To delete the current selection (or the character to the right of the insertion point if no selection), press the
DEL key or select this menu item.



Select All (Edit Menu)

This command selects the entire document.

Shortcuts
Keys: CTRL+A



Word Wrap (Edit Menu)

You can specify that Ecopad automatically wrap text to the beginning of the next line when the text 
reaches the right edge of the window. This does not affect you text file, which retains the full line of 
text.

To set the word wrap option:

From the Edit Menu, choose Word Wrap.

Word wrapping remains in effect until you choose Word Wrap again. If word wrapping is off, you press
ENTER to begin a new line of text.

The word wrap state is persevered when you exit Ecopad.



Insert Time (Edit Menu)

Use this command to insert the current time into the document. The time is inserted in the form 
specified in Windows Control Panel.



Insert Date (Edit Menu)

Use this command to insert the current date into the document. The date is inserted in the form 
specified in Windows Control Panel for "Short Date".



Insert Time/Date (Edit Menu)

Use this command to insert the current time/date into the document.

Shortcuts
Keys: F5



Insert Page Break (Edit Menu)

Inserts a page break character into the document. When printing, a page break character instructs 
Ecopad to begin a new page. The default page break character code is 12 (the ANSI formfeed 
character), but you can specify any number between 1 and 255. The usual reason for changing the 
page break character is to be able to see it on the screen as something other that a box (which is how
the ANSI formfeed character is displayed on the screen). Note that if you change the character to 
something other than 12, Ecopad will not be able to recognize form feed characters in text documents
not created with it, so it is not recommended that you change this value.



Convert to Uppercase (Character Menu)

Converts selected text to upper case. This command is not available if there is no selection.

Shortcuts
Keys: F11



Convert to Lowercase (Character Menu)

Converts selected text to lower case. This command is not available if there is no selection.

Shortcuts
Keys: F12



Switch Case (Character Menu)

Switches the case of selected text to lower if uppercase, upper if lowercase. This command is not
available if there is no text selected.



Convert DOS Text To Windows (Convert Menu)

This command converts DOS text, which uses the OEM character set, to Windows text, which uses 
the ANSI character set. This command is useful if you are loading a file which was created with a 
DOS text editor.

This command is unavailable for read-only files.



Convert Windows Text To DOS (Convert Menu)

This command converts Windows text, which uses the ANSI character set, to DOS text, which uses 
the OEM character set. This command is useful if you will be loading a file into a DOS text editor.

This command is unavailable for read-only files.



Fix CR/LF (Convert Menu)

Text files in DOS/Windows use a carriage return character followed by a line-feed character to 
indicate the end of a line. Text files created for use with other operating systems, however, may use 
just a single carriage return or linefeed.

This function searches through the text for carriage return/ linefeed characters. If a carriage return is 
found without a following linefeed, a linefeed character is inserted. If a linefeed character is found 
without a preceding carriage return, a carriage return is inserted before the linefeed.

This command is unavailable for read-only files.



Configuration (Options Menu)

Use this command to display the Application Options dialog box.



Printing (Options Menu)

Use this command to display the Printing Options dialog box.

Shortcuts
Keys: F7



Screen Font (Options Menu)

Use this command to select the font used for screen display.

Shortcuts
Keys: F2



Printing Font (Options Menu)

Use this command to select the font used for printing.

Shortcuts
Keys: F3



Ecopad™    Version 2.60 Single License Order Form
Ecopad™ and Ecopad32™ are copyright © 1995,1996 by Azure D'or Software.
All rights reserved.
See discount below if paying by check or money order.

See Also: Benefits of Registration
Fax order form

This form can be printed by selecting File/Print Topic from the Help Menu above. If you are unable to print this form, then you can 
send the information below, along with payment, to the address given.
Please Print

Name:_______________________________________________________________________

Company:____________________________________________________________________

Address:_____________________________________________________________________

_____________________________________________________________________________

City:___________________________ State:______ Postal Code:_____________________

Country:_____________________________________________________________________

E-mail Address (Internet, CIS, AOL, etc.)___________________________________________

Where did you obtain your copy of Ecopad?_______________________________________

Price: $19.95
S&H (United States) $4.00

(Other Countries) $6.00

-$3.00 discount if paying with cash/check/money order: -$3.00

Total Enclosed:______________________________

______ Check here if you would like your registration key e-mailed to you. You will also receive an invoice
and disk in the mail.

Company and personal checks are accepted as well as money orders. Purchase orders are accepted from companies and 
educational institutions. The amount shown above is in U.S. dollars. Checks must be in U.S. funds drawn on a U.S. bank.
You may also send U.S. currency.

Please make checks payable to:David T. Ossorio
Send To:

Azure D'or Software
David T. Ossorio
325 S. Washington Ave. #166
Kent, WA    98032
USA

Thank you for purchasing Ecopad!



Ecopad™    Version 2.60 Site License Order Form
Ecopad ™ and Ecopad32™ are Copyright © 1995,1996 Azure D'or Software. All Rights Reserved. 
Site License Fees:

Number of Copies Price Per Copy
2-10 $19.95
11-50 $16.95
51-100 $15.95
101-200 $14.95
201-300 $13.95
301-500 $12.95
501-1000 $11.95
1001-2000 $10.95
More than 2000 $9.95

Please Print

Name:_______________________________________________________________________

Company:____________________________________________________________________

Address:_____________________________________________________________________

_____________________________________________________________________________

City:___________________________ State:______ Postal Code:_____________________

Country:_____________________________________________________________________

e-mail Address (Internet, CIS, AOL, etc.)___________________________________________

Number of Copies:___________________________

Price per Copy:______________________________

Total Enclosed:______________________________

Company and personal checks are accepted as well as money orders. Purchase orders are accepted from companies and 
educational institutions.    The amount shown above is in U.S. dollars. Checks must be in U.S. funds drawn on a U.S. bank.

Please make checks payable to:David T. Ossorio
Send To:

Azure D'or Software
David T. Ossorio
325 S. Washington Ave. #166
Kent, WA    98032
USA

Thank you for purchasing Ecopad!



Purchasing Ecopad

See Also: Benefits of Registration
Fax order form

CompuServe

GO SWREG
Register product #4987

The purchase price will be charged to your regular CompuServe account.

CHECK/MONEY ORDER

Single License Order Form
Site License Order Form

CREDIT CARD ORDERS ONLY

You can order Ecopad ($19.95 + $4.00 shipping & handling) with MasterCard, Visa, American Express, or
Discover from Public Software Library by:

Calling 1-800-2424-PSL    (1-800-242-4775)
Calling 1-713-524-6394

FAX: 1-713-524-6398
CompuServe E-mail: 71355,470
Internet e-mail: 71355.470@compuserve.com

Mail (CREDIT CARD ORDERS ONLY):

PsL
P.O. Box 35705
Houston, TX    77235-5705

PsL requires the following information:

Credit Card [    ] MasterCard    [    ]    Visa    [    ]    AMEX    [    ]    Discover    [    ]
Credit Card Number: ___________________________________________
Expiration Date ___________________________________________
Name On Card: ___________________________________________
Billing Address ___________________________________________

___________________________________________

When ordering with a credit card, be sure to ask for product #11912, and include 
your credit card number and expiration date.

The author of this program cannot be reached at these numbers. 
Any questions about the status of the shipment of the order, 
refunds, registration options, product details, technical support, 
volume discounts, dealer pricing, site licenses, etc. must be 



directed to the following:

David T. Ossorio
325 S. Washington Ave. #166
Kent, WA    98032
USA

Internet:
davossorio@msn.com



Contact Information

Your comments are always appreciated. If you have a question or comment about Ecopad (even if you 
haven't registered), or a feature you would like to see in a future release, I can be reached at the following
addresses:

Azure Dor Software
David T. Ossorio
325 S. Washington Ave. #166
Kent, WA    98032
USA

Internet:
davossorio@msn.com



Printing Options Property Sheet

Page Compression
Printing
Headers
Footers
Margins



Page Compression Dialog

The page compression dialog box lets you select how compressed pages will print.

Layout
Select the number of pages to print on each physical sheet of paper

1x1 No page compression
1x2 Two pages per sheet of paper
1x4 Four pages per sheet of paper
2x2 Four pages per sheet of paper
2x4 Eight pages per sheet of paper

Note that the preview window in this dialog box is designed to give you a general idea, but not an 
exact representation, of how the page will look. Specifically, it will not reflect landscape orientation
if you have selected it from File/Print Setup. The page will print correctly in print preview, however.

Draw
This option lets you select what is drawn between pages.

Lines Pages are separated by vertical/horizontal lines
Pages Frames are drawn around each page
None No lines or frames are drawn

Use Defaults
If you check this box, Ecopad will automatically print with the point sizes you have selected for 
various page layouts (1x2,2x2, etc.), so you dont have to re-enter font information when you 
change the layout.

Defaults
Use this option to display the font point size defaults dialog boxand select default point sizes for 
various page compression layout options.

Font
Displays a choose font dialog box which lets you select the font used for printing.



Font Defaults Dialog Box

If you check use defaults in the page compression dialog, then you can enter a default point size for 
each type of compression (1x2,1x4, etc.) here. When you print the appropriate point size will be used 
for the type of compression selected (so you dont have to change the point size every time you 
change the compression layout).



Printing Setup Dialog 

This dialog lets you select various printing configuration options.

Always Print Using Word Wrap
Normally Ecopad will print using word wrap if the edit window is displaying the text using word 
wrap.    If you check this box, Ecopad will always print using word wrap irrespective of the word 
wrap selection of the edit window.

Filter Blank Lines
When this option is checked Ecopad will replace 2 or more consecutive blank lines with a single 
blank line (thus saving a bit more paper).

Filter Non-ASCII Text
When this option is checked Ecopad will print only characters with valid printable ASCII values (If 
you load a file and see a lot of "garbage" characters, you might try printing with this option 
checked.)

Page Break Character
Here you can enter the decimal value of the Page Break character, which is inserted into the 
document when you choose Edit/Insert Page Break. When printing, if Ecopad sees this character 
it will start a new page.



Footers Dialog

Use this dialog to enter information about footers.

Footer Line 1
Enter the text of the footer.    The following escape sequences are supported:

&P Insert page number
&D Insert the current date in short date format
&T Insert the current time
&M Insert the current time and date
&F Insert the name of the file being printed
&& Insert the '&' character

Justify
Select the justification of the footer

Draw Line Above Footer
If checked, Ecopad will draw a line above the footer



Headers Dialog

Use this dialog to enter information about headers.

Header Line 1
Enter the text of the header.    The following escape sequences are supported:

&P Insert page number
&D Insert the current date in short date format
&T Insert the current time
&M Insert the current time and date
&F Insert the name of the file being printed
&& Insert the '&' character

Justify
Select the justification of the footer

Draw Line Below Header
If checked, Ecopad will draw a line below the header



Margins Dialog

The margins you enter here apply to physical pages (not compressed pages within each physical page).

Left
Enter the left margin

Right
Enter the right margin

Top
Enter the top margin

Bottom
Enter the bottom margin

Inches/Centimeters
Check the unit of measurement for the values entered in the Left/Right/Top/Bottom fields.



Expiration Warning

Ecopad is fully functional for 20 days or 60 uses, whichever comes LAST. For example, if you run 
Ecopad once and then set it aside for a year, you will still be able to run it another 59 times before the 
software expires. Similarly, if you run Ecopad 60 times the first day, you will still have another 19 days to 
evaluate it. Note that when Ecopad shuts down, you will be able to reactivate it without re-installing by 
entering your registration information. Thank you for evaluating Ecopad.

See also:

Benefits of Registration

Single License Order Form
Site License Order Form
How to order with a credit card



How to Uninstall Ecopad
To uninstall Ecopad:
1.    From Program Manager, delete the Ecopad 2.1 program group icon.
2.    Delete all of the files in the \ecopad21 directory (or whatever directory you installed Ecopad).
3.    Delete the file ecopad.ini from your \windows directory.
4.    Ecopad has now been uninstalled.



Notice of Shutdown

Ecopad is fully functional for 20 days or 60 uses, whichever comes LAST. Thank you for evaluating 
Ecopad. If you purchase Ecopad, you will receive a registration number which will enable Ecopad to 
work normally.

You can reactivate this software by entering your registration information.

If you choose not to purchase Ecopad, you should delete it from your hard drive now, as it will no longer 
function.

If you wish, you may extend the evaluation period for 20 days. Send your request for an extension code 
to:

David T. Ossorio
325 S. Washington Ave. #166
Kent, WA    98032
USA

or Internet E-mail:
davossorio@msn.com

The extension code is only valid once.

See Also:

Benefits of Registration

How to uninstall Ecopad
Single License Order Form
Site License Order Form
Other Ways to Purchase



Registration Dialog Box

If you have registered Ecopad, you should enter your registration information here. This will prevent 
Ecopad from shutting down after 20 days or 60 uses.

Name:
Enter your name exactly as it appears on your registration letter.

Company:
Enter your company name. This field is optional.

Key:
Enter your registration key exactly as it appears on your registration letter.

If your registration information is correct, Ecopad will confirm that you have registered when you click the
OK button.

If you have not registered Ecopad, select cancel.
 



Application Options Dialog Box

Confirm Read Only
When checked, Ecopad will ask you to confirm that you wish to load a file as read-only

Always On Top
Check this box to force the application workspace window to remain on top of all other application 
windows

Open Document Windows Maximized
Check this box to open new edit windows maximized

Use Color
Check this box to enable background coloring of the application workspace

Use Menu Titlebar Color
Check this box to use the menu title bar color (which you can set in Control Panel) to fill the 
application workspace.

Open Maximized
Check this box to open Ecopad (that is, the application workspace) maximized

Open New Empty Document on Startup
If this box is checked, Ecopad will open a blank new document each time you run it.

Break Paragraphs At ... Characters
Text created with the Windows Write word processor is stored in paragraphs rather than as a series of
lines. When Ecopad loads a file created with Write, it must decide where to break lines. The value 
here determines the number of characters displayed per line when viewing a Windows Write file.

Note that when printing, this value is not used; instead text is wrapped to fit the page width as it would
be if you were printing from Windows Write itself.



Convert menu commands

The Convert menu offers the following commands:

Convert DOS Text to Windows Convert DOS text (OEM character set) to 
Windows Text (ANSI character set).

Convert Windows Text to DOS
Convert Windows text (ANSI character set) 
to DOS text (OEM character set).

Fix CR/LF Replace single carriage return or linefeed 
characters with a carriage return/linefeed 
pair.



File menu commands

The File menu offers the following commands:

New Creates a new document.
Open Opens an existing document.
Close Closes an opened document.
Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Document 
Information

Display information about the active document.

Exit Exits Ecopad.

Edit menu commands

The Edit menu offers the following commands:

Undo Reverse previous editing operation.
Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.
Del Delete text
Select All Select the entire document
Word Wrap Switch word wrap on/off
Find Find text
Replace Find/Replace text
Repeat Repeat the last editing action
Time Insert the current time in a document
Date Insert the current date in a document
Time/Date Insert the current time/date in a document
Page Break Insert a page break in the document

Character Menu Commands

Convert To Uppercase Convert selected text to uppercase
Convert To Lowercase Convert selected text to lowercase
Switch Case Switch case of selected text



Options Menu

Configuration Select application options
Printing Select printing options
Screen Font Select the font used for screen display
Printing Font Select the font used for printing

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document in Ecopad.

You can open an existing document with the Open command.

Shortcuts
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window.    You can open multiple documents at 
once.    Use the Window menu to switch among the multiple open documents.    See Window 1, 2, ... 
command.

You can create new documents with the New command.

Shortcuts
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open. This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:

.txt Text (ASCII) file

.wri Windows Write File

Note:    Windows Write files will open as read-only, and only the text will be extracted from the file.

Drives
Select the drive in which Ecopad stores the file that you want to open. 

Directories
Select the directory in which Ecopad stores the file that you want to open.

Read Only
Check this box to open the file as read-only.    Note that files larger than 64,000 bytes must be opened
as read only.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active document. Ecopad suggests that you save 
changes to your document before you close it. If you close a document without saving, you lose all 
changes made since the last time you saved it. Before closing an untitled document, Ecopad displays the 
Save As dialog box and suggests that you name and save the document.



Save command (File menu)

Use this command to save the active document to its current name and directory.    When you save a 
document for the first time, Ecopad displays the Save As dialog box so you can name your document.    If 
you want to change the name and directory of an existing document before you save it, choose the Save 
As command.

Shortcuts
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document.    Ecopad displays the Save As dialog box so 
you can name your document.    

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:
File Name

Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    Ecopad adds the extension you specify in the
Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you 
closed.    Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your Ecopad session. You can also use the Close command on the application 
Control menu. Ecopad prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Undo (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the command changes, 
depending on what the last action was.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL+V



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Ecopad,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).



Status Bar

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window.    If 
there is an open document window at the bottom of the main window, then some or all of the icons may 
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

Ecopad displays a list of currently open document windows at the bottom of the Window menu.    A check 
mark appears in front of the document name of the active window.    Choose a document from this list to 
make its window active.    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Ecopad and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Ecopad.



Context Help command 
Use the Context Help command to obtain help on some portion of Ecopad.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the Ecopad window, such as another Toolbar button.    The Help topic will be shown for the 
item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Ecopad window to an icon.

Shortcut
Mouse: Click the minimize icon    on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut
Mouse: Click the maximize icon on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Ecopad determines which window is 
next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Ecopad determines which window 
is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the active edit window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

Use this dialog box to select a font for screen display or printing.    Note that for a true type font, you can 
specify any point size by typing the point size in the Size edit box.



Find command (Edit menu)

Searches for characters or words in a document.    You can match uppercase and lowercase letters and 
search forward or backward from the insertion point.

Shortcut
Key: CTRL+F



Replace command (Edit menu)

Searches for characters or words in a document and replaces them with specified text.    You can match 
uppercase and lowercase letters and search forward or backward from the insertion point.

Shortcut
Key: CTRL+R



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.

Shortcut
Key: F4



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.




